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1  I n t r o d u c t i o n  

1.1 Highlights 
Orion Multi-Trader (“Orion MT”) is a powerful desktop trading application for trading in the futures and equity 
markets. This guide is specifically for Futures traders. Some of the features of the application include the 
following: 

• Easy to use interface with multiple workspaces 
• Fast and intuitive order entry 
• Real-time order and position status updates 
• Real-time charts & streaming quotes 
• Automated System trading 
• Reliable broker and data-feed connectivity 
• Simulated trading environment 
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2  I n s t a l l a t i o n  G u i d e  

2.1 Minimum System Requirements 
• Windows 10 PC with a 2 GHz processor or better 
• 6GB of RAM or more 
• 200 MB or more free hard drive space 
• Minimum 1280x1024 screen resolution with 16 bit color 

2.2 Website Registration 
To get started with Orion MT, please register with a valid email ID at the following website: 
http://www.oriontradingsystems.com 

Once you have successfully registered at the website, you will receive an email confirmation.  Please follow 
instructions on the email on how to install the software. 

2.3 Installation 
To install the application simply run the installer application and follow the on-screen instructions.  You must 
agree to the End User License Agreement (“EULA”) in order to install the application.  Advanced users may select 
their own default locations for the installation files. You may need administrative privileges to install the 
software.  

2.4 Getting Started 
As a futures customer of a partner broker with a valid username and password you 
can easily start trading once the Orion MT is successfully installed.  To launch Orion 
MT, double click on the desktop icon or select the program from the Windows 
Start Menu: 

Start>All Programs> Orion MT 

You will choose whether you want to trade in Demo or Live. 

Next, a login window will pop up in which you will need to select your Broker and 
Order Gateway from the dropdowns provided.  The Order Gateway may offer options such as different 
locations.  If options are available, they can be accessed by clicking on the ellipsis following the Order Gateway 
name.  Next, enter your Gateway username and password.  Select your Market Data provider and click on the 
ellipsis to enter your market data provider credentials.  

Once you have logged in, the application will launch. At this point you can set up 
your preferences and quickly start trading.  You can check out the videos in the 
http://www.oriontradingsystems.com/LearningCenter. 

To login using Orion MT’s built in simulation engine, please select STEAMEngine from 
the Order Gateway dropdown. You will use the following credentials to login: 

Username: ABCD1234 
Password: 1234 

http://www.oriontradingsystems.com/LearningCenter
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2.5 Workspaces 
The application workspace is highly customizable and helps you to optimize your desktop space.  The main areas 
of the workspace include: 

• Menus 
• Dockable Tool Icon Palettes (Not Shown in Image below) 
• Command Line Order Entry (Not Shown in Image below) 
• Workspace Navigation Tabs 
• Streaming Quotes Panel 
• Message Console Window 
• Flashing Alerts Indicator 
• Connectivity Indicators 

While using the application, you can organize your trading layouts neatly in workspaces that can be saved and 
retrieved either individually or collectively as a session.  Each workspace can be named and renamed by invoking 
the right click menu option from anywhere on a grey workspace area or from the drop-down menu options. 

Here are the various operations related to workspaces: 

New Workspace (perform one of the listed options): 
• Perform a shortcut key CTRL+N. 
• Perform a right mouse click anywhere on a grey workspace area and select 

New Workspace from the menu. 
• Click on File>Workspace>New Workspace. 

Open a Saved Workspace:  
• Perform a shortcut key CTRL+O and select a saved workspace file.  
• Perform a right mouse click anywhere on the workspace background and 

select Open Workspace from the menu and select the saved workspace file. 
• Click on File>Workspace>Open Workspace and select the saved workspace file. 

Save a Workspace: 
• Perform a shortcut key CTRL+S and provide a name and file location to the workspace.  
• Perform a right mouse click anywhere on a workspace background and select Save Workspace from 

the menu, give a name and file location to the workspace. 
• Click on File>Workspace>Save Workspace, provide a name and file location to the workspace. 

Rename an Open Workspace: 
• Select the Tab that will be renamed and perform a right mouse click anywhere on the workspace 

area grey background and select Rename Workspace from the menu. 
• Select the workspace that will be renamed and Click on File>Workspace>Rename Workspace. 

Close an Open Workspace: 
• Perform a right mouse click anywhere on the grey workspace area and select Close Workspace 

from the menu.  
• Select the workplace to be closed and click on File>Workspace> Close Workspace. 

2.6 Menu Bar 
The application has the following main menus.  Shortcut keys for each menu are displayed in brackets whenever 
available and a comprehensive shortcut list is also displayed in the Appendices. 
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File (ALT + F) 
Within the file menu, you can choose the following options: 

• Save and Restore Session 
• Workspace - Within the workspace menu, these are the options available: 

 New Workspace (CTRL + N) 
 Open Workspace (CTRL + O) 
 Save Workspace (CTRL + S) 
 Rename Workspace 
 Close Workspace 

• Print (CTRL + P) 
• Exit 

Edit (ALT + E) 
From this menu, you can select the main preferences of the application.  The Preferences are comprehensive 
and are described in detail in the preferences section. 

• General Preferences (CTRL + R) – Customize your order defaults and how you want the system to 
respond when an action occurs (system feedback). 

• Report Preferences (CTRL + T) – Customize your report preferences such as identifying each type of 
order with a different color and preview your changes prior to returning to your workspace. 

• Chart Preferences (CTRL + H) – Customize your drawing, chart and indicators preferences with this 
option. 

• Quote Preferences (CTRL + W) – Customize your quote preferences. 
• Preset Strategies – If available in your subscription, preset strategies will allow you to customize a 

strategy. 
View (ALT + V) 
From this menu item, you can choose the toolbars to be displayed in your workspace layout by selecting the 
toolbar menu name.  These menus will appear at the top of your screen beneath the menu bar. 

• Order Toolbar  
• Systems Toolbar 
• Report Toolbar 
• Command Line Toolbar 
• Quotes Toolbar 
• Charts Toolbar 
• Quotes Table – The quotes table will be visible in your workspace layout. 
• Message Console – The message console will be visible in your workspace layout. 
• Refresh (CTRL + F5) – Refreshes the workspace layout. 

Order (ALT + O) 
From this menu, you have the option of directly launching order related windows.  These include: 

• Single Order (CTRL + SHIFT +O) 
• Parked Order (CTRL + SHIFT + P) – View the parked orders panel. 
• Price Ladder 
• Super DOM1 
• DOM 
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Reports (ALT + R) 
From this menu, all the reports can be launched: 

• Filled Order (F3) 
• Order Status (F6) 
• Order Book (F12) 
• Positions (F7) 
• Intraday P&L (F8) 
• Balances (F9) 
• System Tracker (F10) 

Systems (ALT + S) 
From this menu, the automated trading systems can be launched.  This menu may not be visible in all editions. 

Quotes – (ALT + Q) 
From this menu, windows displaying quotes can be launched: 

• Quotes (CTRL + SHIFT + S) 
• Option Quotes 

Charts (ALT + C) 
From this menu, you can invoke a new chart or load a saved chart: 

• New Chart (CTRL + SHIFT + H) 
• Load Chart (CTLR + SHIFT + L) 

Windows (ALT + W) 
From this menu, you can select the following options related to windows layouts: 

• Cascade 
• Tile 
• Close All 
• Move To 
• Float 

Help (ALT + H) 
From this menu, you can launch the help documents or read about the application.  The following menu sub-
items are available: 

• User Manual (F1) 
• About (F2) 
• User Agreement 
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3  O r i o n  M T  F u t u r e s  S y m b o l s  a n d  P r i c e  F o r m a t  

3.1 Introduction to Orion MT’s Symbols 
Orion MT supports a large number of futures contracts.  Additional symbols are constantly added.  Please ask 
your broker if you don’t see a contract that you want to trade.  A sampling of the more popular symbols is 
shown below: 

Base Symbol Description Exchange 

6B British Pound GLOBEX 
6C Canadian Dollar GLOBEX 
6E EuroFX GLOBEX 
ES E-mini S&P 500 GLOBEX 
ZF 5 Year Treasury Notes CBOT 
ZG 100 oz. Gold CBOT 
6J Japanese Yen GLOBEX 
NQ E-Mini Nasdaq GLOBEX 
ZN 10 Year Treasury Notes CBOT 
ZB 30 Year Treasury Bonds CBOT 
YM Mini sized $5 Dow Jones GLOBEX 

3.2 Symbol Naming Convention 
The symbol naming convention used within the application is based on existing and widely used standard 
exchange conventions in the futures industry. Futures contracts can be specified by providing two pieces of 
information: The Root Symbol and the Date.  These are then concatenated with a “+” sign. For example, ES+H17 
refers to the E-Mini S&P 500 futures contract that expires in March 2017.  

• Root Symbol -  The Base Exchange Symbol 
• Date - Date represents the month and year when contract will expire. Date Format can be broken 

into two parts i.e. <MonthYear> - Month followed by Year, e.g. Z17 where Z stands for December 
and 17 represents “Year 2017”.  The month letters are mapped from the following table: 
 

Month Letter Month Letter 

January F July N 
February G August Q 
March H September U 
April J October V 
May K November X 
June M December Z 

 

For options you have to augment the symbol with the corresponding root, type and strike. Examples:  

ES+H17+C2250  ES 3rd Friday, March 2017, 2250 Call option.   
ES.W1+F17+P2250  ES 2250 Put option that expires on the first Friday in January. 
ES.WW2+F17+P2250  ES 2250 Put option that expires on the second week Wednesday of January. 
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3.3 Futures Contract Price Format Convention 
Orion MT application supports a flexible and intuitive price format to enter orders as well as for displaying prices 
within quote windows, reports or charts. The application supports the following price formats: 

• Decimal Format - Requires a decimal point. 
• Tick Format - Single Tick 1/32nd’s requires an apostrophe (’) mark, and half ticks 1/64th’s requires 

the quote mark (”). 
• Standard Long Format - No decimals or tick marks. 

 
The following table displays contract specifications and also displays samples prices as you would need to enter 
in the application. 

Base 
Symbol Point Value 

($) Minimum 
Tick Size Tick Value 

($) Market 
Price Long 

Format Decimal Tick Half Tick 

ES 50.00 .25 12.5 1025.50 120550 1205.50 1205’16 1205’’32 
ZB 1000.00 1/32 31.25 112 20/32 112200 112.625 112’20 112’’40 
YM 5.00 1 5.00 12192 12192 12192.00 12192’0 12192’’0 
ZN 1000 1/64 15.625 108 3/64 108015 108.15625 n/a 108’’03 
ZF 1000 1/64 15.625 107 2/32 107020 107.0625 107’02 107’’04 
ZG 100 .1 10 625.5 6255 625.5 625’16 625’’32 
NQ 20 .25 5 1770.25 177025 1770.25 1770’08 1770’’16 
6E 125000 .0001 12.5 1.2500 125000 1.2500 1’8 1’’16 
6J 125000 .0001 12.5 .007500 75000 .007500 n/a n/a 
6B 62500 .0001 6.25 1.9061 19061 1.9061 n/a n/a 
6C 100000 .0001 10 0.8871 88710 0.8871 n/a n/a 
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4  O r d e r  P l a c e m e n t  
Orion MT offers many choices for entering and managing orders.  These are described in detail in this section. 

4.1 Order Ticket 
The application provides an order preview or an order confirmation ticket for orders submitted by you unless 
the “Skip Order Preview” check box is selected, or if you have launched automated trading systems.  The order 
ticket allows you to review and possibly change the order parameters before final submission to the exchange.  
You should review all orders carefully before submission through the application/tool.  Be aware that once the 
“Skip Orders Preview” checkbox is checked, this option is active for your entire session unless you uncheck it.  
We recommend that new users keep this box unchecked. 

 

4.2 Price Ladder 
Orion MT supports many different price ladder modules.  The standard price ladder, SuperDOM I, combines 
streaming quotes with a powerful order management system to create a user friendly visual display. All active 
orders for a particular portfolio or price ladder can be displayed and managed in the window itself.  Key 
Features: 

• You can rapidly place, replace or cancel orders. 
• Allows you to place buy or sell orders for 

selected quantity. 
• You can change the color format of the Price 

Ladder window by right clicking and editing its 
properties. 

• You can hide the order panel for optimal use of 
the desktop.  (Shortcut Key: F4) 

• Actions - The ‘action’ can be either a complex 
order type or an automated system.  The 
introduction of an action within the price ladder 
allows for the rapid launch of complex strategy-
based trades. 

Any price ladder module can be launched either from the 
Order menu bar, using Shortcut keys or toolbar. The 
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SuperDOM I panel is divided in two sections: the market depth or the price ladder display window and the Order 
Panel. 

Price Ladder Display Window Layout - The main price ladder window provides the following set of columns. 

• Buy Side of the Ladder 
 Action - A preset buy action can be initialized from this column once the price has been 

activated. 
 X - Cancel Buy Orders 
 Buy Orders - All active buy orders are displayed here and the quantity of any order can be 

changed by right clicking on that order.  If there are multiple orders working at the same 
price, you can right-click on the orders and select a single order to cancel. 

 Buy - Displays the price where if selected a buy limit order will be placed.  Other order 
types can be placed by right clicking on the price. 

• Center Column – Displays the current cost basis with an outlined box.  Additionally, a price can be 
activated for actions by selecting the price you want the action to occur. 

• Sell Side of the Ladder 
 Sell - Displays the price where if selected a sell limit order will be placed.  Other order types 

can be placed by right clicking on the price. 
 Sell Orders - All active sell orders are displayed here and the quantity of any order can be 

changed by right clicking on that order. 
 X - Cancel Sell Orders.  Any active sell orders can be cancelled by selecting the red X. 
 Action - A preset sell action can be initialized from this column once the price has been 

activated. 

• Bottom of the Ladder- -There are 5 buttons and a checkbox. 
 Up and Down Arrow Buttons - Allow you to move the price ladder up and down.  (Shortcut: 

Up and Down Arrow Keys) 
 Auto Center Checkbox - Brings the center price to the market price.  (Shortcut: Space Bar) 
 ≡ Button - Zooms in on the prices in the price ladder.  (Shortcut: +) 
 = Button - Zooms out on the prices in the price ladder.  (Shortcut: -) 
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4.3 Order Panel Layout 
The order panel has the following features: 

• Buy Mkt - Allows you to place Buy market order. 
• Buy Ask - Allows you to rapidly place an order to Buy at the ‘Ask’ 

price. 
• Buy Bid & Offset Spinner Box - Allows you to place a Buy limit order at 

the price specified by the current bid plus the desired offset. 
• Sell Mkt - Allows you to place Sell MKT order. 
• Sell Bid - Allows you to rapidly place an order to Sell at the Bid. 
• Sell Ask & Offset Spinner Box - Allows you to place a Sell limit order at 

the price specified by the current ‘ask’ plus the desired offset. 
 
• Cancel All - Allows you to cancel all current orders for the current 

symbol displayed in the ladder. 
• Close Position - Closes the current position for the symbol being 

viewed. 
• Position - Displays the current position (Flat, Long or Short) followed 

by the number of contracts for that position. 
• Cost Basis - Displays the current cost basis of the open lots using a 

FIFO rule. 
• P&L - Displays the real-time profit and loss balance for the symbols. 
• Account Number - Allows you to select one of the listed options. 
• Symbol - Lists all the symbols set by the general preferences.  Only one selection can be made at a 

time. 
• Qty - Specifies the default quantity for orders placed in price ladder. 
• Skip Preview - Allows you to place an order without bringing up an order ticket. 
• Good Till Cancel (GTC) - When this box is checked, all orders placed in price ladder will be good till 

cancelled. 
• Automated Bracket Order - To associate an exit order with a new order, simple set the Profit and 

Stop Loss tick values and select the corresponding OCD checkbox.  All entry orders will now have a 
“One Cancels Another” bracket exit orders based on these settings.  Like all automated trading 
systems, this feature should be used carefully. 

• Strategy Trading 
 Buy Action - This contains a list of preset buy actions that can be initiated by selecting the 

buy button in the action column.  
 Sell Action - This contains a list of sell preset that can be initiated by selecting the sell 

button in the action column.  
 Mode – LMT, MKT, STOP 
 Run Strategy in Background – Enables an automated strategy to run in the background. 

4.4 Single Order 
The single order panel is the basic order entry panel in the application.  From this panel, you can submit orders 
to the exchanges or ‘Park’ orders into the Park Order Window. 
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• Single Order Window - Can be launched either from the menu bar, shortcut keys or toolbar.  To 
formulate an order, you need to set up the following fields: 

• Account - The dropdown box displays valid account number(s).  Accounts can be edited from the 
General Preferences. 

• Buy/Sell - Select Buy or Sell. 
• Contract - Contract specifications are set by selecting the following: 

 Symbol - Drop down box provides list of preferred symbols.  This is an editable field though 
only allowed symbols can be traded. 

 Month - Selection from 1 to 12. Default is the current month. 
 Year - Select-ion for the year of expiration.  The default year is the current year. 

• Order 
 Quantity - Allowed selections are 1 to 99. 
 Type - Allowed Order Types: MKT/LMT/STOP/STWL. 
 Price - Price can be entered here for Buy/Sell contracts in the allowed price format. For 

MKT order type, this field is disabled. 
 Stop with Limit Price - This input box is enabled only when STWL order type is selected. 
 TIF (Time in Force) - gives you the option of placing DAY orders or Good Till Cancel orders 

(“GTC”).  
 Preview & Submit - If all required fields are filled clicking this button will displays the order 

ticket for placing your order. Otherwise, it brings up the appropriate message. 
 Park Order - If all required fields are filled, clicking this button parks your order in the 

Parked Orders.  
 Clear - Clicking this button resets all the fields to its default values. 
 Skip Order Preview - Allows you to place orders immediately without bringing up the order 

ticket. However, a warning message is displayed when this check box is enabled. Once this 
check box is selected, the “Preview and Submit” button changes to either “Submit Buy 
Order” or “Submit Sell Order” facilitating a rapid one-click order entry.  
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4.5 Parked Orders 
The parked order panel is a useful panel for staging orders and for organizing orders prior to the trading session.  
The park order panel also allows you to filter orders by Account, Symbol and order type and to create and 
submit batch orders.  Remove After Placing checkbox will remove the orders from the parked orders window 
once you click send orders on the parked order confirmation ticket. 

To ‘park’ an order, you must set up the order using a single order window, and press the park button.  To place a 
single order from the parked order rows, simple 
press the ‘trade’ button.  To place multiple orders 
simultaneously, select the desired orders and then 
press the ‘place selected’ button.  You can also use 
the filters to only select those orders that meet 
the desired filter criteria.  Once the group of 
orders is selected, press the ‘Place Selected’ 
button to submit the orders for execution.  A 
group order confirmation ticket will be displayed 
for order review. 
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4.6 Chart Order Panel 
Order placement from charts is facilitated by a side “Order Panel” which can be easily hidden or displayed via 
the “F4” function key toggle.  Active orders are displayed on the charts via “order lines” by selecting the “Show 
Orders” checkbox and “Show Order Lines”.  The order lines provide a useful display of working orders relative to 
possible support and resistance points in the underlying market. The 
chart order panel is almost identical to the Price Ladder order panel.  
The main difference is that the chart order panel has additional 
features such the ‘Show Orders’ check box, ‘Show Order Lines’ check 
box and the Trade Mode buttons.  These additional features are 
described below. 

• Show Order Lines - By selecting this checkbox, you will be 
able to display a horizontal line for each order that spans 
the entire length of the visible chart.  This allows 
technically oriented traders to focus on support and 
resistance points and place or adjust their orders 
accordingly. 

• Show Orders - This option allows you to display all 
working orders for the symbol on the chart.  This allows 
you to rapidly adjust orders by simply dragging and 
dropping the orders right on the charts. 

• Trade Mode Options - From the charts, you have the 
option of five different trade modes.  Once any of the 
trade mode buttons are clicked, you will be able to place 
a single order in which the limit or stop price of the order 
is automatically selected from the price at which the 
mouse is clicked on the chart.  Once the order is 
submitted, the application will revert back to the normal 
chart mode.  The five trader modes are: 
 Buy Limit - This mode allows the placement of a 

single buy limit order. 
 Sell Limit - This mode allows the placement of a single sell limit order. 
 Buy Limit/Stop - This mode allows the placement of either: 

(1) a buy limit order below, or 
(2) a buy stop order above the current market price. 

The application automatically switches to the correct order type depending on the vertical location 
of the cursor relative to the last price.  The order type is indicated by the cursor which will either 
display “BL” or “BS”. 

 Sell Limit/Stop - This mode is the opposite of the previous trade mode in which the orders 
are now either 1) a sell limit order above or 2) a stop buy order below the current market 
price.  The order type is indicated by “SL” or “SS” respectively. 

 Buy/Sell Limit - The last trade mode allows the placement of: 

(1) Buy Limit order below, or  
(2) Sell Limit order above the last market price. 
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• Action Strategies - From the charts, you have the option to initiate strategies directly from the 
chart. Once a strategy and the ‘BUY’ or ‘Sell” button is selected, you will be able to start a strategy 
in which the limit or stop price of the strategy is automatically selected from the price at which the 
mouse is clicked on the chart. Once the order is submitted, the application will revert back to the 
normal chart mode. 

• Buy Action - This contains a list of buy presets that can be initiated by selecting the buy button. 
• Sell Action - This contains a list of sell presets that can be initiated by selecting the sell button. 

4.7 Streaming Quotes Order Panel 
The streaming quotes panel provides a useful mechanism to place orders without having to invoke any of the 
dedicated order placement panels.  

Order placement from the 
quote panel is relatively 
simple.  If you click on any 
valid price field of the 
desired futures symbol on 
the quote page, the 
corresponding order details 
are automatically 
generated. Next, you can 
simply preview and submit 
the order or if the ‘skip 
order preview’ box is 
checked, the order is ready 
for rapid submission. 

4.8 Command Line 
This simple, but powerful utility allows you to 
enter orders using command line syntax.  The 
grammar is simple and intuitive—you have to 
enter the following fields in order: 

• Acct # 
• Buy or Sell (B or S) 
• Quantity 
• Contract Specification (ES+M6) 
• Order Type (MKT, LMT, STOP) 
• Price (if LMT or STOP Order)

 (Decimal, Tick or Long) 
Examples:  Suppose you want to place orders for E-mini S&P September 2016 futures and options contracts in 
account numbered ABC123, then the following is a list of sample orders: 

ABC123 BUY 2 ES+U16 MKT 
ABC123 BUY 4 ES+U16 LMT 137500 
ABC123 BUY 4 ES+U16 LMT 1375.00 
ABC123 SELL 2 ES+U16 STOP 136500 
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5  R e p o r t s  
Orion MT supports a wide range of report panels allowing traders a full view of the daily trading activity and 
their real-time portfolio positions and balances. 

5.1 Order Status 
The order status report provides traders a detailed view of the current working order as well as orders that have 
been cancelled or replaced.  The application automatically updates the table values as any order related 
messages are received and processed.  However, occasionally, the application may fall out of synchronization 
with the exchange or broker database and the refresh button in the order status allows you to manually update 
the table as well.  The status column may display the following types of messages: Active, Pending, Cancelled, 
Replaced or Rejected.  You may also filter order status by selecting a single account or you can view all of your 
accounts. 

 

To trade from the Order Status Report right-click on any valid price field and a drop-down menu will appear.  To 
cancel an individual order, select any price field in the row, right-click and select the drop down option “Cancel”.  
To replace an order, right-click on a valid price on that row and select “Replace” on the drop down menu.  A 
replace order ticket will be displayed. 

5.2 Filled Orders Report 
The filled order report provides a detailed view of all the confirmed fills for the day.  In addition, the filled order 

panel 
also 
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supports filtered views of orders.  Orders can be filtered both by symbol and by order type.  You can also 
highlight a set of rows or columns by dragging your cursor and then right-click to copy and paste the selected 
table into a spreadsheet application. 

5.3 P&L Table 
The Profit & Loss or P&L table provides a useful real-time calculation displaying the true cost basis and the 
realized or unrealized profit and loss of any intraday futures transactions. 

By setting up the commissions from the Edit>General Preferences>Commission menu, the values displayed in 
the table will always provide a realistic P&L Statement which takes commission costs into account.  To trade 
from the P&L table, right-click on any price and a drop-down menu provides the option to trade. 

 

5.4 Positions Table 
The positions table provides a real-time view of the current portfolio and is updated automatically as new 
transactions are reported.  In addition, you have the option of manually requesting a fresh update of the 
positions table from the back-end database. 

The first tab labeled ‘Current Positions’ displays all the lots traded including positions carried overnight.  The 
second tab, labeled “Summary”, displays a full summary of the portfolio.  As is prevalent throughout the 
application, you have the choice of ‘Right-clicking’ any price field in a row and creating orders rapidly. 
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5.5 Balances 
The balances panel displays the current portfolio balances.  This report 
does not update automatically. Press the ‘refresh’ button to update the 
table. 

5.6 Order Book 
The order book window provides a complete status of all active and non-
active orders.  By selecting the appropriate checkbox, you can get a 
complete summary of your order book rapidly.  Like the other reports, you 
can also manage your orders via a right-click menu option.  You can cancel 
multiple orders by simply selecting the check box corresponding to those 
orders and then selecting the ‘Cancel X Selected’ button. 

 

5.7 System Tracker 
Orion MT’s System Tracker provides you with a quick and easy to monitor financial summary of all the 
automated Systems (Trend Trader, etc.) used during a session. You can view the summaries of currently active 
systems, as well as all systems that have been completed or aborted.  
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6  Q u o t e s  

6.1 Introduction 
The quotes panel is a versatile tool not only for tracking the markets but also for placing orders directly from the 
panel.  The right-click menu of the quote panel provides you with the ability to quickly launch charts or other 
quote panels such as market depth (when available). 

Key Features: 

• Trade directly from 
the quotes panel 

• Organize your 
symbols by 
maintaining quote 
lists 

• Optimize your 
desktop space by 
maintaining multiple 
tabs 

• Customize your 
layout and the look 
and feel of the quotes 
panel easily 

The quotes panel supports two types of layouts: Horizontal or Vertical.   In addition, you can customize the look 
and feel by simply making the appropriate settings in the comprehensive quote preferences invoked by right-
clicking anywhere within the quotes window.  The following is the drop-down menu option: 

For example, to create a new quote tab, simply select the drop-down option 
under the “Tab” menu. 

To invoke the preference dialog box, simply select “Preferences” to change the 
settings for the current panel.  To change default quote preferences, select 
Edit>Quote Preferences from the main menu.  From the quote preferences, 
you can easily change their layout settings, manage their quote lists, and setup 
default charts properties. 
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7  C h a r t s  

7.1 Introduction 
The charts within Orion MT provide powerful visual displays of historical and real-time streaming market price 
actions.  The charting system is comprehensive and supports many different functions. 

Key Features: 

• Provides broad timeframes of historical and real-time streaming plot displays. 
• Provides wide array of drawing tools. 
• Save and retrieve charts. 
• Allows you to overlay and customize technical indicators. 
• Save and load indicator templates. 
• Allows you to place and manage your orders directly from the window. 
• Wide range of plotting indicators.  
• Easily customize the layout and the look and feel of the charts from the comprehensive preference 

setting option. 
• Allows you to export data to a spreadsheet. 
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7.2 Chart Layout and Usage 
The charting system in Orion MT is comprehensive and has an extensive set of tools and settings that are 
available either from the side toolbars, the order panel or the right-click menu options. 

• Charts Toolbar - From the charts toolbar, you can perform the following tasks: 
 Draw Lines 
 Draw Fibonacci Support and Resistance lines 
 Draw Gann Fans 
 Apply grid lines 
 Compress & Expand the time axis 

To hide or unhide the chart toolbar, right-click anywhere on the charts and select the “Drawing 
Toolbar” menu item. 

• Indicators - Orion MT supports a large set of well known (and some lesser known) indicators.  These 
are available by right-clicking on the chart and choosing “indicators”.  You can also save your 
favorite group of indicators as a template and then apply the saved template to any open chart.  
(Please note that drawing objects such as lines are not part of the saved template). 

• Chart Interval - To change chart intervals simply select the appropriate checkboxes and the desired 
interval and duration. 

• Chart Order Panel - The Chart order panel allows you to place and manage orders efficiently.  The 
chart order panel is described in detail in the Order Placement section.  To display or hide the chart 
order panel, simply press F4. 

• Export Chart Values - Select ‘export data’ from the right-click menu. 
• Chart Preferences - Select ‘properties’ from the right-click menu option. 
• Change an Indicator - Select the ‘indicator’ you wish to change and a right-click menu will provide 

the option to change the indicator properties. 
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8  S y s t e m s  
Orion MT provides robust and reliable automated trading systems.  We will describe Trend Trader in this 
section. Please note that your edition of Orion MT may not support Trend Trader.  Other systems will be 
available via online downloads. 

8.1 Trend Trader 
Trend Trader is a mechanical system that 
allows you to place sequential buy and sell 
limit orders.  For example, if you opt to trade a 
BUY-SELL chain, then based on the parameter 
settings, the system will generate a series of 
BUY-SELL-BUY-SELL--- chain of limit orders, 
each dependent on the execution price of the 
preceding order.  Trend Trader allows you to 
maintain tight risk controls by placing Stop 
Orders only if you have an open position. For 
example, in a BUY-SELL chain, once a buy order 
is executed, both a Sell Limit order and a 
corresponding Sell STOP order will be active 
based on users’ parameters. 

The Trend Trader window can be launched 
either from the menu bar, shortcut keys or 
toolbar.  To formulate an order, you need set up the following fields: 

• Account - The dropdown box displays valid account number(s).  Accounts can be edited from the 
General Preferences. 

• Quantity - Allowed selections are 1 to 99contract for each trade that takes place through Trend 
Trader 

• Contract - Contract specifications are set by selecting the following: 
 Symbol - Drop down box provides list of preferred symbols.  This is an editable field though 

only allowed symbols can be traded. 
 Month - Selection from 1 to 12. 
 Year - Selection for the year of expiration. 

• Order: 
 Chain - Select to begin Trend Trader with a BUY-SELL chain or a SELL-BUY chain. 
 Type - MKT/LMT/STOP 
 Price - Price can be entered here for Buy/Sell contracts in the allowed price format.  For 

MKT order type, this field is disabled. 

• Sell Parameter: 
 Difference - Enter the number of ticks that the next sell LMT order will be placed with 

respect to the last buy filled order. 
 Increment - Enter the number of ticks that Difference (above) will increase by.   
 Inc Frequency (Increment Frequency) - Enter the number of sell trades after which the 

Increment will be added to the Difference  
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 Order Delay - Enter the delay in seconds to place the LMT orders after the last fill is 
received.  (NOTE: STOP orders are immediately placed.) 

• Buy Parameter 
 Difference - Enter the number of ticks that the next buy LMT order will be placed with 

respect to the last sell filled order. 
 Increment - Enter the number of ticks that Difference (above) will increase by.   
 Inc Frequency (Increment Frequency) - Enter the number of buy trades after which the 

Increment will be added to the Difference 
 Order Delay - Enter the delay in seconds to place the LMT orders after the last fill is 

received.  (NOTE: STOP orders are immediately placed.) 

• Max Loss - The Max Loss is entered in ticks which are used to place the Stop Order every time a 
trend trader enters a position.  The Stop Order will be placed the number of ticks specified from the 
last filled order. 

• Links - Enter the total number of buy and sell orders to be placed by Trend Trader. 
• Start - Clicking this button pops up a preview of the set parameters or an error messages if any of 

the parameters are wrongly entered. Clicking OK will start the Trend Trader. 
• Abort - Clicking this button cancels all working orders placed by this Trend Trader. 
• Simulate - Clicking on this button creates a simulation graph of all the LMT orders of what will be 

placed by Trend Trade.  If Price is not entered, as in the case of MKT orders, Trend Trader will ask 
for a start price before displaying the graph. 
 

Example:If you start a Trend Trader for ES+U16 with a BUY-SELL chain that starts with a LMT order at 214500 
and the user defined parameters as follows:  

Sell Parameters Buy Parameters Max Loss: 48 ticks Links (Trades): 10 
Difference: 4 ticks Difference: 2 ticks     
Increment: 4 ticks Increment: 3 ticks       
Inc Frequency: 4 Inc Frequency: 2      
Order Delay: 0 Order Delay: 0     

A quick way to view the orders that will be generated is by invoking the “Simulate” button.  Thus for this 
example, the following chart representing the sequence of orders.  
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9  A p p e n d i x  A :  P r e f e r e n c e s  

9.1 Introduction 
Orion MT is a highly versatile application and can be easily customized to meet the unique needs of each trader.  
This is accomplished through the comprehensive set of preference dialogs available in the application.  These 
are displayed here for reference. 

9.2 General Preferences 
• Settings - From this section, you can set/edit your account settings, preferred month, year and 

quantity of each symbol being traded.  You can also change the sound and color settings for the 
console messages from this window. The price display format for the application can also be 
changed here. 

 
• Commissions - From this section, you can setup your commissions for individual symbols.  This 

information is used to calculate the values displayed in the P&L report. 
 

• Data Feed - From this section, you can easily setup alternate data feed connections.  You can also 
specify a set of symbols that Orion MT will automatically download data once the application is 
started. 
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• Expiration - From this section, you can setup your expirations for futures contracts. 

 

• Symbol - From this dialog section, you can establish your preferred list of symbols to trade from 
within the order entry related panels. 
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• Symbol Conversion - From this 
section, you can setup your 
preferred session times for 
individual symbols.  These values 
are used to control the display of 
charts and other modules that 
may require session related 
information. 
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9.3 Report Preferences 
You can easily customize the appearance of individual 
reports from this section.  The color schemes of all 
reports can be changed to fit your preference.  In 
addition to all reports, the color scheme may be 
changed for the following:  Order Book, Parked Orders, 
Filled Orders, Active Orders, Cancelled/Replaced 
Orders, Account Position, P&L Report, and Balances. 

 

 

 

 

 

9.4 Chart Preferences 
• Basic - You can opt 

to display Grid 
Lines, Cursor 
Display and invoke 
the tools in a 
default persistent 
mode by selecting 
the appropriate 
check boxes.  In 
addition, users can 
setup the main 
color palette for 
their charts. 

• Drawing Objects - 
The application 
supports a fairly extensive set of drawing tools.  The default setting for each drawing tool can be 
established from this section. 

• Indicators - Orion MT’s basic charts support an extensive set of indicators—the default parameters 
for these indicators can be setup from this section.  Please note that individual indicators will have 
their own format for setup. 

• Favorites - From this section, you can setup your favorite symbols which will appear in the drop 
down menu in the charts. 
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9.5 Streaming Quote 
Preferences 

You can set up the defaults for the 
quotes window from this section.  The 
default columns to display, the color 
scheme for the quotes, the layout 
mode (Horizontal or Vertical), and the 
price format used to display the 
quotes (Exchange long or Decimal) 
can all be set up from the quote 
preferences.  In addition, you can 
setup your default settings for charts 
launched from the right-click option 
available from quotes.  You can also 
maintain your default symbol lists 
here. 

 

 

 

9.6 Preset Strategies 
The Preset Strategies window allows you to easily 
start different types of order strategies from Price 
Ladder and Chart.  From one location you can 
view all strategies you have saved throughout the 
application.  Once the preset strategy is setup, 
you can enable a quick launch of the strategy 
from the Price Ladder or Chart. 

 



Orion Trading Systems 
 

30 

 

© 2017 SU2 Systems Inc. 
 

1 0   A p p e n d i x  B :  S T E A M  I n t e r f a c e  

10.1 Introduction 
The STEAM Interface allows you to monitor and adjust the setting for the simulated trading environment 
provided within Orion MT. The STEAM Engine simulates most of the broker functionalities and provides 
simulation order execution and trading matching services. It provides the capability to test the implementation 
of order and account management features in the Orion MT application. It also can be used for application 
training and demo purposes.  STEAM uses the same data feed as Orion MT application.  Once logged and 
authenticated, STEAM will be automatically launched with two default simulated accounts: ABCD1234 and 
ABCD5678. 

To Launch the STEAM Interface: (This may not be enabled for all editions of Orion MT) 

• Shortcut key:  Ctrl + Alt + S 

10.2 Accounts Panel 
Under the Accounts Tab in STEAM you can Modify Accounts by adding accounts, deleting accounts, adding cash, 
and removing cash. 

 

• Add Accounts - In the NEW ACCOUNTS area, enter the name of the new account and the amount of 
cash you would like in this account.  Then simply press the create account button to create a new 
account. 

• Delete Accounts - Select the account you would like to remove from the existing account area.  
Then push the delete account button to remove the account.  
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• Add/Remove Cash - Select the account in the existing account area that you would like to add or 
remove cash from.  Then enter the amount of cash you would like to add or remove and push the 
appropriate button.  Add Cash button for adding cash and the Withdraw Cash button for removing 
cash.  

10.3 Contract Table Panel 
Below is a list of all editable fields in the Contract Table Panel of the interface which you can change using 
STEAM: 

 

• Symbol - Enumerates all the commodities root symbols that Steam engine can be used to trade. 
• Tradable Month - The alphabet representation of the months that the contract can be traded for. 
• Auto Futures Last Trade - The Last day the contract can be traded. Represented in an integer 

format for the number of months different from the Tradable Month input.  All Auto Futures trades 
are assumed to stop trading on the third Friday of the month represented by the integer. 

• Auto Futures Last Delivery - The day after which any position will be closed. Represented in an 
integer format for the number of months different from the Tradable Month input.  All Auto 
Futures Last Delivery trades are removed from the account (cash settlements) on the last day of the 
month represented by the integer. 

• Manual Last Trade Front Month - If entered this date will replace the Auto future last trade. 
• Manual Last Delivery Front Month - If entered this date will replace the Auto future last delivery. 
• Initial Margin - Required dollar amount for purchasing one contract. 
• Maintenance Margin - Required dollar amount for maintaining one contract. 
• New Commission - Commission for opening a new position for the contract. 
• Offset Commission - Commission for closing an open position for the contact. 
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• Exchange Fees - Any exchange fees if needed for the contact. This field is editable. 
• Other Charges - Additional fees for the contract. 

10.4 Filled Orders 
The STEAM Engine also allows you to view all your filled orders and make changes to the quantity and trade 
price.  This feature is often helpful in developing strategies. 
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1 1  A p p e n d i x  C :  S h o r t c u t  L i s t    

11.1 Orion MT Shortcut Key Guide 
Cntrl+Alt+S  STEAM Interface  
Cntrl+Shift+M  Market Trader 
Cntrl+Shift+O  Single Order 
Cntrl+Shift+P  Parked Order 
Cntrl+Shift+S  Quotes 
Cntrl+L   Login 
Cntrl+D   Logout 
Cntrl+N   New Workspace 
Cntrl+O   Open Workspace 
Cntrl+S   Save Workspace 
Cntrl+R   General Preferences 
Cntrl+T   Report Preferences 
Cntrl+H   Chart Preferences 
Cntrl+W  Quote Preferences 
 
Function Keys 
F1   Help 
F2   About 
F3   Filled Orders 
F5   Refresh Orders in Charts & Price Ladder 
F6   Order Status 
F7   Account Positions 
F8   P&L Report 
F9   Balances 
F12   Order Book 
 
 
Chart Shortcuts 
F4   Chart Order Panel Toggle 
Cntrl+Shift+H  Chart 
Cntrl+Shift+L  Load Chart 
Alt+A   Save Chart 
Alt+G   Grid 
Alt+I   Draw Fibonacci 
Alt+L   Draw Line 
Alt+N   Draw Gann Fan 
Alt+P   Start Persistent Mode 
Alt+U   Insert Volume  
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